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***** 1st Class *****
Adobe Premiere:

Adobe Premiere 6.5 is software that brings the world of digital video editing to the Windows and Macintosh desktop. We can edit video or audio with Premiere. A video editor who is new, he / she can learn video editing to easy with Premiere. And an expert video editor who can get many options to edit video or audio at Premiere. Adobe Premiere provides extensive support for video capture cards, hardware systems, and many input/output formats. Moreover, Adobe Premiere provides a consistent work environment with other Adobe applications including Adobe Photoshop, Adobe Illustrator, Adobe InDesign, Adobe GoLive, Adobe LiveMotion, and Adobe After Effects.
System Requirement for Windows Operating System:

· Intel Pentium Processor

· Microsoft Windows 95 / 98 / 2000 / Windows NT / Windows XP

· Apollo Quick Time 3 or Microsoft Video for Windows latest
·  64MB RAM
· Large HDD

· 256 Display Card (24 bit Display Card for TV)

· CD ROM Drive

· Sound Card

· Color Monitor

To Install Adobe Premiere 6.5:

· Insert CD into CD ROM

· (CD will be auto run)

· [image: image82.png]A Adobe Premiere " I M@K

huiyan Computers,:Mymensingh Branc

A Adobe premi.. | Factor A adsbepremi.. | @)1 %) 2, 4imepm




Open Premiere Folder

· Open Serial.txt File

· Copy Serial Number

· Then Close the File

· Open Setup.exe File

· Click Next
· Click Next

· Click Accept
· Select Custom

· (You can change Destination Directory)
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Click Next

· Click Next

· Fill up the ‘User Information’ Form
· Click Next

· Click Yes

· Click Next

(Installation process will be started.)
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(After 95% Complete you will get ‘Quick Time 5 Setup’ window
You can install it or not, but you should install it if you didn’t install Quick Time before.)

· Click Next

· Click Next
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Click Agree

· (You can change Destination Directory)

· Click Next

· Click Next

· Click Next
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Click Next
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Click Next
· Check on all Select viewer associations:

· Click Finish
· Click Close
· Click Accept
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· (Select ‘Yes, I want to restart my computer now.’)

· Click Ok
(Wait, system will be restarted.)
To Start Adobe Premiere:

· Click Start Menu

· Point to Programs

· Point to Adobe

· Point to Premiere 6.5

· Click Adobe Premiere 6.5

WORKSPACE
Selecting an initial workspace:
When you start Premiere for the first time (or when the Preferences file has been deleted), Premiere asks you to select an initial workspace. Based on your decision, Premiere optimizes the layout you will use to assemble and edit programs. Your choice of workspace depends on the kind of editing you will be doing.

If you will primarily be dragging clips from the Project window to the Timeline, select the A/B Editing workspace. If you will be using more advanced editing techniques such as three- or four-point editing, select the Single-Track Editing workspace.

Managing the window workspace:
When you start Premiere for the first time, or after deleting or renaming the Preferences file, you are prompted to select the editing workspace. You can also select a different editing workspace at almost any time while working on a project. You can also create custom window layouts by rearranging the windows and changing their settings.
You can save your favorite custom window layouts and apply them to any project. Saving a workspace preserves the locations of Project, Monitor, Timeline, and Audio Mixer windows. Other windows, such as the Clip window, are not saved. However, no window option settings are saved with workspaces.

Note: You should not switch between A/B Editing and Single-Track Editing modes, as it is possible in A/B mode to place clips in positions which are not allowed in Single-Track mode.

To save a custom window workspace:
· Arrange the Project, Monitor, Timeline, and Audio Mixer windows the way you want them, including size, location, and settings. 

· Choose Window > Workspace > Save Workspace. 

· Type a name for the workspace, and click Save. The new workspace is added to the Workspace menu. 
To Select or Delete a Custom Workspace:
· To select a workspace, choose Window > Workspace and then choose the name of a 3workspace. 

· To delete a workspace, choose Window > Workspace > Delete Workspace, choose a name, and click Delete.

PROJECTS
About Project:

A project is a single Premiere file that describes a video program. It stores references to all the clips in that file and contains information about how you arranged the clips. It also includes details of any transitions or effects you applied. You can add and remove clips, organize clips into bins within the project, and substitute low-resolution clips as placeholders for your final, high-resolution clips.

Project Settings:

After select a Workspace you will get ‘Load Project Settings’ dialog box. You can select a default setting or you can customize it.

If you want to select a default setting, chose a default setting from Available Presets – 
· Select DV – NTSC Real-time Preview (Standard 32kHz) or DV – PAL Real-time Preview (Standard 32kHz) or any one
· Click Ok

Note – ‘DV – NTSC’ is used for European Broad Casting and ‘DV – PAL’ is used for Asian Broad Casting.
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If you want to select custom settings –

· Click Custom…

· Change Options from ‘New Project Settings’ dialog box
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· Click Next
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· Click Ok
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Premiere Project

Note – You can settings your Project as you choice.

· In the Project there are Project Window, Monitor Window, Timeline Window and some palettes (Effect Controls, Navigator, Transitions, and Video etc.).

Project Window






Using the Project Window's Bin View:
A Project window includes a bin view, which shows the bins that have been added to the project. The bin view appears on the left side of the Project window, and can be resized or hidden. When the bins in the bin view contain other bins, the hierarchical structure appears, much like the graphical view of folders and subfolders in your operating system. 
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A. Thumbnail viewer B. Bins C. Clip D. Find E. New Bin F. Create Item G. Delete Selected Items H. Resize Bin Area I. Icon View J. Thumbnail View K. List View L. Clip information M. Project window menu 
· To hide or display the bin view: 

Choose Hide Bin Area or Show Bin Area from the Project window menu. 

· To resize the bin view: 

Drag the Resize Bin Area button located at the bottom of the Project window until you have the size you want. You cannot make the bin view smaller than the four buttons below it. To make it bigger, you may need to first make the Project window bigger. 

· To add or delete a container in the bin view: 

· To delete one or more bins, select the bin and click the Delete Selected Items button ([image: image8.png]


) at the bottom of the Project window. 

· To add a bin, click the New Bin button ([image: image9.png]


) at the bottom of the Project window. 
· To display the contents of a bin in the bin view: 

Select the bin. If the bin contains other bins, click the triangle beside the bin icon to display them, and then select the bin you want to view.

Monitor Window






The Monitor window displays individual frames of clips and the video program. Using the Single-Track Editing workspace, the Monitor window resembles the monitors in a conventional edit bay with one monitor for the source, or source clip, and another for the program, or edited video in the Timeline. Controllers at the bottom of the Monitor window are like the edit controller in an edit bay. You can edit clips in either the Monitor window or the Timeline window. (A source clip is a clip outside the Timeline or in the Source view of the Monitor window; a program clip is a clip in the Timeline or Program view of the Monitor window.)
Timeline Window





The Timeline is a time-based view of your program where you can select, arrange, and modify the instances of the source clips you've used in the video program. The Timeline graphically shows the placement of each clip in time, its duration, and its relationship to the other clips in the program.
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A. Work area markers B. Preview indicator area C. Work area bar D. Edit line marker E. Work area band F. Timeline window menu G. Selection tool H. Superimpose Track I. Toggle Track Ouput icon J. Video 1 tracks K. Audio track L. Track Header buttons M. Lock icon N. Time Zoom Level popup O. Track Options Dialog button P. Toggle Snap to Edges button Q. Toggle Edge Viewing button R. Toggle Shift Tracks Options button S. Toggle Sync Mode button 
***** 2nd Class *****
IMPORTING CLIPS
· To make a project we have to import Movie Clips, Audio Clips, and Image Files as we needed. And these elements will be arranged into ‘Bin View’ area.
· You can import clips into Premiere as a single clip, multiple clips, or an entire folder of clips directly into the Project window. If you want to examine a clip before importing it into the project, open the clip in a Clip window and then move the clip to the Project or Timeline window. Clips cannot exceed 4000 x 4000 pixels. If the software you use to create art does not let you specify pixels as a unit of measure, specifying points may be sufficient. If the file does not include pixel aspect ratio information, Premiere uses the Interpretation Rules.txt file, which can be customized, to determine the pixel aspect ratio based on codec’s, image sizes, and other parameters. 

By default, Premiere alters the size and aspect ratio of a video clip or still image to match that of the video frame you specified for your project. Premiere displays images with the correct frame aspect ratio in the Monitor and Trim windows.
Premiere can import a number of video, audio and image formats
	Video formats
	Audio formats
	Still-image and sequence formats

	· Type 2 AVI, MOV, and Open DML (Windows only)

Note: Type 1 AVI clips must be rendered before they can be previewed from your DV device. To render a Type 1 AVI clip, add it to the Timeline in a DV project, and build a preview file of that section of the Timeline.


	· AVI, MOV, AIFF, WAV (Windows only), the Macintosh Sound Format, (Mac OS only), and Sound Designer I & II (Mac OS only)
	· AI and AI sequence, PSD and PSD sequence, GIF and animated GIF, Filmstrip, JPEG, PICT and PICT sequence, TGA and TGA sequence, TIFF and TIFF sequence, PCX (Windows only), FLC/FLI (Windows only), BMP and BMP sequence (Windows only), and PICS animations (Mac OS only)


To Import Movie Clips:
· Click File Menu

· Point to Import

· Click File…
· Select Location

· Select a Movie Clips (.mpeg / .avi or any supported format)
· Click Open
To Import Audio Clips:

· Click File Menu

· Point to Import

· Click File…

· Select Location

· Select an Audio Clips (.mp3, .wav or any supported format)
· Click Open

To Import Image Clip:

· Click File Menu

· Point to Import

· Click File…

· Select Location

· Select a Image Clip (.jpeg / .bmp / .tiff or any supported format)
· Click Open
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To Trim Image and Movie Clip:
· Select a Movie or an Image Clip from Bin
· Then Drag and Drop it Video 1A Track or any Track of Time Line Window
· Select Razor Tool and Click on the Clip (Where you need to Trim)

· Then Delete Unnecessary Clip or Set it to another Track
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Edit menu:


We can edit clips by edit menu. We can cut, copy, clear, select to clips by edit menu.
To Cut a Clip:
· Select a Clip

· Click Edit Menu

· Click Cut
· Select another Track

· Click Edit Menu

· Click Past

To Copy a Clip:
· Select a Clip

· Click Edit Menu

· Click Copy

· Select another Track

· Click Edit Menu

· Click Past

To Delete or Clear a Clip:

· Select a Clip

· Click Edit Menu

· Click Clear

To Duplicate to a Clip:

· Select a Clip

· Click Edit Manu

· Click Duplicate Clip…

· Click Ok

To Select All Clips:

· Click Edit Menu

· Click Select All

To Deselect All Clips:

· Click Edit Menu

· Click Deselect All

Undo:

This command use for reverses the last command or delete the last entry you typed. The command name changes to Can’t Undo if you can’t reverse the last action.

To Undo:

· Click Edit menu

· Click Undo

Redo:

When you use the Undo command to reverse an action the Repeat command changes to Redo. The Redo command reverses the action of the Undo command.

To Redo:

· Click Edit menu

· Click Redo

To Find a Clip from Bin View:

· Select Bin

· Click Edit Menu

· Click Find…

· Type Clip Name

· Click Find

· Click Done
***** 3rd Class *****
Project Menu

We can do project related work with Project Menu, like re-change project settings, to view project settings etc.
Project Settings: 
The project settings, which are organized into five categories – 

1. General
2. Video

3. Audio

4. Keyframe and Rendering

5. Capture
To Project Setting:
1. General Settings
· Click Project Menu

· Point Project Settings
· Click General
· Change Settings (Editing Mode, Timebase, Time Display etc.) as you Choice

· Click Ok 

Description of General Settings are given bellow –

· Editing Mode:

Determines which video method is used to play video back from the Timeline and which compression methods are listed in the Video Settings panel. The QuickTime editing mode is installed with Premiere. In Windows, the Video for Windows and DV Playback editing modes are also installed. Manufacturers of video-capture cards or other video hardware may provide plug-in software that adds editing modes for maximum quality and compatibility with their hardware.

· Timebase:

Specifies the time divisions Premiere uses to calculate the time position of each edit. In general, choose 24 for editing motion-picture film, 25 for editing PAL (European standard) and SECAM video, 29.97 for editing NTSC (North American standard) video, or 30 for other video types. Do not confuse timebase with the frame rate of the video you play back or export from the Timeline, although timebase and frame rate often use the same value.

· Time Display:

Specifies the way time is displayed throughout the project. The time display options correspond to standards for editing video and motion-picture film. For broadcast NTSC video, choose 30 fps Drop-Frame Timecode if that was the time display used by the original video. For video to be played back from the Web or CD-ROM, choose 30 fps Non Drop-Frame Timecode. For PAL and SECAM video, choose 25 fps Timecode. For motion-picture film, choose Feet + Frames 16mm or Feet + Frames 35mm. To count individual frames and audio samples instead of timecode, choose Frames/Samples.

· Advanced Settings:

This button may be available if you have installed an editing mode plug-in provided by another manufacturer. For information on settings for your plug-in editing mode, see the documentation provided by the plug-in's manufacturer.

· Playback Settings:

This button is available when you use a DV preset or choose the DV editing mode (Windows) or QuickTime editing mode (Mac OS), or if you have installed a plug-in that provides additional playback functions. When you use the DV (Windows) or QuickTime (Mac OS) editing mode, use this option to indicate where you want your previews to play back: on your DV camcorder or other connected device, or on your desktop. For information on the playback settings available for third-party plug-ins, see the documentation provided by the manufacturer of the plug-in.

· Current Settings:

Displays a summary of the settings you specified in all Project Settings panels.

2. Video Settings
· Click Project Menu

· Point Project Settings

· Click Video

· Change Settings (Compressor, Depth etc.) as you Choice

· Click Ok 

Description of Video Settings are given bellow –

· Compressor:

Specifies the codec (compressor / decompressor) for Premiere to apply when building a preview of the Timeline, the codecs available depend on the Editing Mode specified by your preset or selected in the General Settings panel. Click Configure (if available) to set options specific to the selected codec, if you chose an editing mode provided by a manufacturer of a video-capture card or other hardware, see the documentation for the hardware, as it may recommend a particular codec for editing with that hardware. Otherwise, consider choosing a fast codec so that edits are processed quickly. If you want to play video back through your capture card to an NTSC or PAL monitor, choose the codec specific to your capture card.

Note: If you use a clip in your video program without applying effects or changing frame or time characteristics, Premiere uses the clip's original codec for playback. If you make changes that require recalculation of each frame, Premiere applies the codec you choose here.

· Depth:

Indicates the color bit depth, or number of colors to include in video played back from the Timeline. This button may not be available if the selected compressor provides only one option for bit depth. You can also specify an 8-bit (256-color) palette when preparing a video program for 8-bit color playback, such as for the Web or for some presentation software. The Palette button may be available when 256 Colors is chosen, if the selected Editing Mode and Compressor support creating custom palettes. When the button is available, click it and then either select Make Palette from Movie (to derive a color palette from the frames used in the video program) or Load Palette Now (to import a color palette you prepared and saved previously). You can load color palettes stored in the .ACO (Photoshop color swatch), .ACT (Photoshop color palette), or .PAL (Windows palette--Windows only) format.

· Frame Size:

Specifies the dimensions, in pixels, for frames when you play back video from the Timeline. Ideally, you want the frame size for your project to match the frame size of your video clips. A large frame size shows more detail but requires more processing. If preview playback is slow, you can reduce the frame size to a smaller dimension, as long as your capture card supports it. When changing the frame size, keep the dimensions proportional to the original video clip.

· 4:3 Aspect:

If you're using analog captured video, select 4:3 Aspect to constrain the frame size to the 4:3 aspect ratio used by conventional television. If you are using a D1/DV NTSC pixel aspect ratio, do not select this option.

· Frame Rate:

Indicates the number of frames per second to play back video from the Timeline. In general, type a value that matches the frame rate of the final video, or type a lower value to process previews faster. When changing the frame rate, make sure that the new rate is evenly divisible by the original rate. For example, if your original frame rate is 29.97, lower it to 14.985, or if it is 30 fps, lower it to 15 or 10 fps.

· Pixel Aspect Ratio:

Set the aspect ratio for individual pixels. Choose Square Pixels for analog video, scanned images, and computer-generated graphics, or choose the format used by your video. If you use a pixel aspect ratio that is different from your video, the video may play back and render with distortion.

· Quality:

Affect the picture quality and disk space used when you play back video from the Timeline. Low quality usually plays faster and uses less disk space, and may be preferable for editing. High quality provides the best-looking image the selected compressor can provide, but requires more disk space. You can change the quality setting while working on a project without causing distortions or affecting the final output. Some codecs, such as DV codecs, use a fixed quality level and do not provide access to this option.
· Data Rate:

If available for the selected compressor, places an upper limit on the amount of video data that Premiere compiles for previews. Do not set the data rate higher than the data transfer capacity of your system. Select Limit Data Rate to _ K/Sec and type the data rate required. If previews do not play smoothly, reduce this value. By default, Premiere recompresses frames that use different settings than those selected in the Video settings dialog box. Select always from the Recompress menu to compress every frame even if it is already within the data rate, or select Maintain Data Rate to preserve quality by compressing only the frames that are above the specified data rate.

2. Audio Settings

· Click Project Menu

· Point Project Settings

· Click Video

· Change Settings (Rate, Format, Compressor etc.) as you Choice

· Click Ok 

Description of Audio Settings are given bellow –

· Rate:
In general, higher rates provide better audio quality when you play audio back from the Timeline, but they require more disk space and processing. Resampling, or setting a different rate from the original audio, also requires additional processing time and affects the quality; try to capture audio at the final rate. Note that with DV audio, you can capture only at the rate that was originally used to record the audio. In this case, it's best to match the predominant rate of the clips in your project. If you want to use a different rate in your final output, you can export at a different rate to resample, or you can change the rate in the project preset when you are done editing.

· Format:

Higher bit depths and stereo provide better quality but require more disk space and processing.

· Compressor:

Specifies the codec for Premiere to apply when playing audio back from the Timeline, the codecs available depend on the Editing Mode you specified in the General panel in the Project Settings dialog box. Click Advanced Settings (if available) to set options specific to the selected codec. Generally, you don't want to compress audio for playback from the Timeline; instead, compress audio when exporting.

· Interleave:

Specifies how often audio information is inserted among the video frames in the preview file that is created when you play audio back from the Timeline. This value is set by the preset you choose and generally does not require adjusting. A value of 1 frame means that when Premiere plays back a frame, the audio for the duration of that frame is loaded into RAM so that it can play until the next frame appears. If the audio breaks up when playing, the interleave value may be causing the computer to process too much audio at once. Decreasing the value makes Premiere store longer segments that need to be processed less often, but it requires more RAM.
· Enhanced Rate Conversion:

When you play audio back from the Timeline, this option specifies a level of quality for converting the sample rates of clips in the Timeline to the sample rate you specified in the Rate and Format options. Enhanced Rate Conversion controls both rate upsampling and downsampling. The Off option resamples audio the fastest, but produces moderate quality. The Good option balances quality and processing time. The Best option resamples audio for the highest possible quality but requires the most processing time. Because this option can affect playback performance, you may want to select Off while editing, and then select Better or Best for the final render after you have finished editing or when you are exporting.

· Use Logarithmic Audio Fades:
Controls how audio gain increases or decreases are perceived during playback in Premiere. Select this option to process gain levels using the logarithmic scale used by the human ear and by conventional volume controls. Deselect this option to process gain changes using a linear curve. Selecting this option creates more natural-sounding changes as sounds become louder or softer, but increases audio processing time. Audio faders in the Timeline are not changed except as a result of this option's processing of the overall gain level. 

· Create Audio Preview Files If There Are _ or More:
Specifies when Premiere creates an audio preview instead of real-time playback, based on how many audio tracks are active and how many audio effects are applied in those tracks. The number of audio tracks active and effects applied directly affects the load on your system resources. When your system resources are exceeded by audio processing demands, you will hear pops and clicks while playing back audio in Premiere. If you encounter this problem, decrease the settings for these parameters so that Premiere creates audio preview files instead of trying to process more than it can handle.

3. Keyframe and Rendering

· Click Project Menu

· Point Project Settings

· Click Keyframe and Rendering

· Change Settings (Rendering Options, Fields etc.) as you Choice

· Click Ok 

Description of Keyframe and Rendering Settings are given bellow –

· Ignore Audio Effects:
Select to render audio without applied audio effects.

· Ignore Video Effects:
Select to render video without applied video effects.

· Ignore Audio Rubber Bands:
Select to render audio excluding changes made to the Timeline's rubberband controls for audio fading and audio panning.
· Optimize Stills:
Select to use still images efficiently when rendering video. For example, if a still image has duration of 2 seconds in a project set to 30 frames per second, Premiere will create one 2-second frame instead of 60 frames at 1/30 of a second. Deselect this option if the exported video file exhibits playback problems when displaying the still images. This option is determined by your preset. Some capture cards do not support optimized stills--if you are using a preset provided by your capture card, do not adjust this setting. 

· Frames Only at Markers:
Select when you want to render only the frames at which you have added a marker in the Timeline. This option does not affect compression keyframes.

· Preview:
Choose to Screen when you want to preview edits, transitions, and effects but don't care if the preview is at final playback speed. When To Screen is selected, Premiere renders directly to the screen as quickly as possible. Playback speed depends on image size and resolution, the number and complexity of effects and transitions, and the processing speed of your system. This option is not recommended for previewing areas that include many effects. Choose From Disk when you want to preview edits, transitions, and effects at the final playback speed. With this option selected, Premiere renders the preview to the hard disk. Choose From RAM when you want to preview edits, transitions, and effects quickly, without having to first render a preview file. When From RAM is selected, Premiere creates a preview by displaying frames as they are rendered. Because frames are rendered in RAM, this process depends on the amount of RAM available. If sufficient RAM is not available or if the frame rate, frame size, or effects used require more RAM than is available, frames may be dropped during playback, or Premiere may render the preview to disk instead. To minimize the effects of limited RAM, use a smaller frame size (for example, 320 x 240 or 240 x 180). A smaller frame size also produces a more even frame rate during Preview to RAM. If you have chosen From RAM or To Screen, you can speed up previewing by choosing 1:2 or 1:4 to reduce resolution. Choose 1:1 for normal resolution. To preview with the selected option, choose Timeline > Preview or press Enter (Windows) or Return (Mac OS). To stop a preview, press the spacebar. 

· Field settings:
Select an option that matches the playback display. This option is set by your preset. If you use a preset provided by your capture card, do not change this setting. No Fields is the default and is the equivalent of progressive scan. Some DV cameras offer a "frame movie mode," which resembles progressive scan. If you shot your video using this mode, or if you're using video that is anything other than interlaced, use No Fields. Select Lower Field First for interlaced DV video to maximize motion smoothness. For analog video, select either Upper Field First or Lower Field First, depending on your capture card specifications, when your final output will be played back on a television monitor using an interlaced standard such as NTSC, PAL, or SECAM. Choosing the wrong field settings causes the video to flicker or appear jagged when rendered and played back on an NTSC monitor. 

Some codecs support compression keyframes, which can increase the effectiveness of compression by acting as starting points for temporal compression. Temporal compression looks for ways to compact the description of the changes during a sequence of frames. It does this by looking for patterns and repetition over time. If the codec you specified supports compression keyframes, the following Keyframe Options are available:

· Keyframe Every _ Frames:
Select and type the number of frames after which the codec will create a compression keyframe when exporting video.

· Add Keyframes at Markers:
Select to create a compression keyframe at each marker.

· Add Keyframes at Edits:

Select to create a compression keyframe between each clip.

4. Capture Settings

· Click Project Menu

· Point Project Settings

· Click Video

· Change Settings (Capture Format) as you Choice

· Click Ok 

Description of Capture Settings are given bellow –

· Capture Format

Control how Premiere transfers video and audio directly from a deck or camera. (Other Project Settings panels do not affect capturing.) For more information about capture settings, see Digitizing analog video as DV and Preparing for DV video capture. (Help Menu)
To View Settings:
· Click Project Settings

· Click Settings Viewer

· (after view)

· Click Ok

To Remove Unused Clip: [If you like to delete all clips from Bin.]
· Click Project Menu

· Click Remove Unused Clip

To Replace Clips:

· Select a Clip

· Click Project Menu

· Click Replace Clip…

· Select Location

· Select a File 

· Click Ok

To Automate to Timeline:

· Select a Bin or Two / More Clips
· Click Project Menu

· Click Automate to Timeline

· Change Options as you Choice

· Click Ok

To Export Bin from Project:
· Select a Bin

· Click Project Menu

· Click Export Bin from Project…

· Select Location

· Type File Name

· Click Ok

***** 4th Class *****
Clip Menu

To View Clip Properties:
· Select a Clip

· Click Clip Menu

· Click Properties

· (After View)

· Click Close

To Change a Clip Name:

· Select a Clip

· Click Clip Manu

· Click Set Clip Name Alias…

· Type a Name

· Click Ok

To Insert a Clip at Edit Line:

· Set Edit Line Marker at 0:00:04:00 Second or as you Choice
· Select a Clip

· Click Clip Menu

· Click Insert Clip at Edit Line
To Overlay a Clip at Edit Line:

· After Insert a Clip at Edit Line

· Select a Clip
· Click Clip Menu

· Click Overlay Clip at Edit Line

To Disable Clip on Timeline:
· Select a Clip from Timeline

· Click Clip Menu

· Uncheck Enable Clip on Timeline

To Enable Clip on Timeline:

· Select a Clip from Timeline

· Click Clip Menu

· Click Enable Clip on Timeline

To Lock Clip on Timeline:

· Select a Clip from Timeline

· Click Clip Menu

· Click Lock Clip on Timeline

To Unlink Audio and Video:

· Select a Video Clip from Timeline

· Click Clip Menu

· Click Unlink Audio and Video

To Maintain Aspect Ratio:
· Select a Clip from Timeline

· Click Clip Menu

· Point to Video Options

· Click Maintain Aspect Ratio

To Change Aspect Fill Color:

· Select a Clip (which is maintained by Aspect Ratio) from Timeline

· Click Clip Menu

· Point to Video Options

· Click Aspect Fill Color…
· Change Color

· Click Ok

Transparency Option

This option is very important for video editing. You should use help menu to get more information or to understand about Transparency option.
Transparency Option (1):
· Insert a Clip on Timeline (Video 1A)

· Insert a Clip on Timeline (Video 2)

· Select the Clip from Timeline (Video 2)
· Click Clip Menu

· Point to Video Options

· Click Transparency…

· Select ‘Chroma’ from ‘Key type’
· Select Color of the Clip from Color Option
· Increase Similarity as you necessary

· Increase Blend (if it is need)

· Select ‘High’ from ‘Smoothing’
· Click Ok

· Then Preview

Transparency Option (2):
· Insert a Clip on Timeline (Video 1A)

· Insert a Clip on Timeline (Video 2)

· Select the Clip from Timeline (Video 2)

· Click Clip Menu

· Point to Video Options

· Click Transparency…

· Select ‘RGB Difference’ from ‘Key type’

· Select Color of the Clip from Color Option

· Increase Similarity as you necessary

· Select ‘High’ from ‘Smoothing’

· Click Ok

· Then Preview

Transparency Option (3):
· Insert a Clip on Timeline (Video 1A)

· Insert a Clip on Timeline (Video 2)

· Select the Clip from Timeline (Video 2)

· Click Clip Menu

· Point to Video Options

· Click Transparency…

· Select ‘Luminance’ from ‘Key type’

· Threshold = 100 (by default)

· Cutoff = 0

· Click Ok

· Then Preview

Transparency Option (4):
· Insert a Clip on Timeline (Video 1A)

· Insert a Clip on Timeline (Video 2)

· Select the Clip from Timeline (Video 2)

· Click Clip Menu

· Point to Video Options

· Click Transparency…

· Select ‘Alpha Channel’ from ‘Key type’

· Select ‘Reverse Key’

· Click Ok

· Then Preview

Transparency Option (5):
· Insert a Clip on Timeline (Video 1A)

· Insert a Clip on Timeline (Video 2)

· Select the Clip from Timeline (Video 2)

· Click Clip Menu

· Point to Video Options

· Click Transparency…

· Select ‘Image Matte’ from ‘Key type’

· Click Choose… button from Matte Option

· Select Location

· Select an Image or a Shape

· Select ‘Reverse Key’ or Not

· Click Ok

· Then Preview

Motion Option


Motion option is very important for video editing. You should use help menu to get more information or to understand about Transparency option.

Motion Option (1):
· Insert a Clip on Timeline

· Select the Clip

· Click Clip Menu

· Point to Video Options

· Click Motion…

· Click Ok

· Then Preview

Motion Option (2):

· Insert a Clip on Timeline

· Select the Clip

· Click Clip Menu

· Point to Video Options

· Click Motion…

· Select Start Point
· Click Center

· Set Zoom = 0

· Select End Point

· Click Center

· Set Zoom = 100 (by default)

· Click Ok

· Then Preview

Motion Option (3):

· Insert a Clip on Timeline

· Select the Clip

· Click Clip Menu

· Point to Video Options

· Click Motion…

· Select Start Point

· Click Center

· Set Zoom = 0

· Set Rotation = 360

· Select End Point

· Click Center

· Set Zoom = 100 (by default)

· Click Ok

· Then Preview

Motion Option (3):

· Insert a Clip on Timeline

· Select the Clip

· Click Clip Menu

· Point to Video Options

· Click Motion…

· Select Start Point

· Click Center

· Set Zoom = 0

· Set Rotation = 360

· Select End Point

· Click Center

· Set Zoom = 100 (by default)

· Click Ok

· Then Preview

Motion Option (4):

· Insert a Clip on Timeline

· Select the Clip

· Click Clip Menu

· Point to Video Options

· Click Motion…

· Select Start Point

· Set Info: # 0 is at 27 and -19

· Set Zoom = 35

· Create a Point

· Set Info: # 0 is at -26 and -19

· Set Zoom = 35

· Create a Point

· Set Info: # 0 is at -26 and 20

· Set Zoom = 35

· Create a Point

· Set Info: # 0 is at 27 and -20
· Set Zoom = 35
· Create a Point

· Set Info: # 0 is at 27 and -19

· Set Zoom = 35

· Create a Point

· Set Info: # 0 is at 27 and -19

· Set Zoom = 0

· Create a Point

· Click Center

· Set Zoom = 0

· Set Rotation = 360

· Select End Point

· Click Center

· Set Zoom = 100 (by default)

· Click Ok

· Then Preview
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Motion (4)
Motion Option (5):

· Insert a Clip (.jpg – 352 x 364) on Timeline (Video 1A)
· Select the Clip from Timeline

· Click Clip Menu

· Click Duration

· Set Duration - 0:00:10:00

· Copy the Clip & Past it Video 2 Track

· Click Timeline Menu
· Click Add Video Track & Past the Clip Video 3 Track

· Click Timeline Menu

· Click Add Video Track & Past the Clip Video 4 Track

· Click Timeline Menu

· Click Add Video Track & Past the Clip Video 5 Track
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· Right Click on Clip of Video 5 > Point to Video Options > Click Motion…
· Select Start Point

· Set Info: # 0 is at 24, -17

· Set Zoom = 32

· Select End Point

· Set Info: # 0 is at -24, -17

· Set Zoom = 32

· Click Ok

· Right Click on Clip of Video 4 > Point to Video Options > Click Motion…

· Select Start Point

· Set Info: # 0 is at -24, -17

· Set Zoom = 32

· Select End Point

· Set Info: # 0 is at -24, 17

· Set Zoom = 32

· Click Ok

· Right Click on Clip of Video 3 > Point to Video Options > Click Motion…

· Select Start Point

· Set Info: # 0 is at -24, 17

· Set Zoom = 32

· Select End Point

· Set Info: # 0 is at 24, 17

· Set Zoom = 32

· Click Ok

· Right Click on Clip of Video 2 > Point to Video Options > Click Motion…

· Select Start Point

· Set Info: # 0 is at 24, 17

· Set Zoom = 32

· Select End Point

· Set Info: # 0 is at -24, 17

· Set Zoom = 32

· Click Ok
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· Set Edit Line Marker 0:00:02:00 Second

· Click Collapse/Expand Track of Video 5 & Create a Alpha Key Point
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· Click Collapse/Expand Track of Video 4 & Create a Alpha Key Point

· Click Collapse/Expand Track of Video 3 & Create a Alpha Key Point

· Click Collapse/Expand Track of Video 2 & Create a Alpha Key Point

· Set Edit Line Marker 0:00:08:00 Second
· Create Alpha Key Point on Video 2, Video 3, Video 4, and Video 5
· Drag First & Last Point of Alpha Key Down of Video 5

· Drag First & Last Point of Alpha Key Down of Video 4

· Drag First & Last Point of Alpha Key Down of Video 3

· Drag First & Last Point of Alpha Key Down of Video 2

· Then Preview
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Motion (5) Timeline
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To Frame Hold (In Point or Out Point):
· Insert a Video Clip on Timeline

· Click Clip Menu

· Point to Video Options

· Click Frame Hold…

· Check On ‘Hold On’

· Select In Point or Out Point from ‘Hold On’

· Click Ok


To Frame Hold (Select Frame):

· Insert a Video Clip on Timeline

· Move the Edit Line to the Frame you want

· Click Clip Menu

· Point Clip Marker

· Select 0 (Poster Frame)

· Click Clip Menu

· Point to Video Options

· Click Frame Hold…

· Check On ‘Hold On’

· Select Marker 0 from ‘Hold On’

· Click Ok

Pixels Aspect Ratio
Pixel aspect ratio specifies the ratio of width to height of one pixel in an image. Frame aspect ratio describes the ratio of width to height in the frame dimensions of an image. To get more information about Aspect Ratio use Help Menu.

To Change Pixel Aspect Ratio:

· Select a Clip

· Click Clip Menu

· Point to Advanced Options

· Click Pixels Aspect Ration
To Change Clip Duration:

· Select a Clip

· Click Clip Menu

· Click Duration…

· Then Change Duration

· Click Ok

To Change Speed:

· Select a Clip

· Click Clip Menu

· Click Speed…

· Then Change Speed (New Rate)

· Click Ok
To Open a Clip:

· Select a Clip

· Click Clip Menu

· Click Open Clip

To Open Master Clip:

· Select a Clip

· Click Clip Menu

· Click Open Master Clip

To Set Clip Marker:
· Set Edit Line Marker on Timeline like 0:00:04:00 Second
· Click Clip Menu

· Point to Set Clip Marker
· Click 0 (Poster Frame)

If you like to set more clip marker

· Set Edit Line Marker on Timeline like 0:00:16:00

· Click Clip Menu

· Point to Set Clip Marker

· Click 1

By this way you have to set clip marker.

To Go to Specified Clip Marker:

· Click Clip Menu

· Point to Go to Clip Marker

· Click 0 / 1 / In / Out / as you like
To Clear Clip Marker:

· Click Clip Menu
· Point to Clear Clip Marker

· Click 0 / 1 / All Markers / as you like
***** 5th Class *****
Timeline Menu

To Preview:
· Edit Image Clip or Video Clip

· Click Timeline Menu

· Click Preview


To Render Work Area:

· Edit Image Clip or Video Clip

· Click Timeline Menu
· Click Render Work Area

· After Finish Rendering Move ‘Edit Line Marker’ on Clip

To Render Audio:

· Edit Audio Clip

· Click Timeline Menu

· Click Render Audio

· After Finish Rendering Click Play Button from Monitor Window
To Razor at Edit Line:
· Insert a Clip
· Set Edit Line 0:00:04:00 Second or as you Choice

· Click Timeline Menu

· Click Razor at Edit Line

To Ripple Delete:

· After Razor Clip

· Select 1st Clip & Delete It

· Select Blank Area

· Click Timeline Menu

· Click Ripple Delete

To Zoom In:
· Insert a Clip

· Click Timeline Menu

· Click Zoom In

To Zoom Out:
· Insert a Clip

· Click Timeline Menu

· Click Zoom Out

To Add Video Track:

· Click Timeline Menu

· Click Video Menu

To Add Audio Track:

· Click Timeline Menu

· Click Audio Track

Track Options (To Add Video or Audio Track):
· Click Timeline Menu

· Click Track Options…

· Click Add…

· Type Number into Add (Video or Audio) Box

· Click Ok

· Click Ok

Track Options (To Delete Video or Audio Track):
· Click Timeline Menu

· Click Track Options…

· Select Track (Video or Audio)

· Click Delete

· Click Ok

Track Options (To Change Track Name):
· Click Timeline Menu

· Click Track Options…

· Select Track (Audio or Video)

· Click Name…

· Type Name into Name Box

· Click Ok

· Click Ok

To Hide Shy Track:
· Point to Mouse Pointer on Toggle Track Output (Eye)

· Press Ctrl + Click Toggle Track Output (Eye)
· Click Timeline Menu
· Click Hide Shy Track

To Show Shy Track:

· Click Timeline Menu
· Click Show Shy Track

To Set Timeline Marker:
· Set Edit Line Marker 0:00:04:00 Second or as you Choice
· Click Timeline Menu

· Point to Set Timeline Marker

· Click 0

By this way you can set more Timeline Marker
To Go to Timeline Marker:

· Set Edit Line Marker 0:00:32:00 or as you Choice
· Click Timeline Menu

· Point to Go to Timeline Marker

· Click 0

By this way you can go to any Timeline Marker

To Clear Timeline Marker:

· Click Timeline Menu

· Point to Clear Timeline Marker

· Click 0

By this way you can clear any Timeline Marker

To Edit Timeline Marker:
· Click Timeline Menu
· Click Edit Timeline Marker…

· Change Options

· Click Ok

Window Menu

To Settings Project Window:

· Click Window Menu

· Point to Window Options

· Click Project Window Options…

· Change Options

· Click Ok

To Settings Timeline Window:
· Click Window Menu

· Point to Window Options

· Click Timeline Window Options…

· Change Options

· Click Ok

To Settings Monitor Window:

· Click Window Menu

· Point to Window Options

· Click Monitor Window Options…

· Change Options

· Click Ok

To Settings Audio Mixer Window:

· Click Window Menu

· Point to Window Options

· Click Audio Mixer Window Options

· Change Options

· Click Ok

To Change Workspace:

· Click Window Menu

· Point to Workspace

· Click to a Workspace (Single-Track Editing or A/B Editing)
To Save Workspace:

· Click Window Menu

· Point Workspace

· Click Save Workspace…

· Type a Name into Name Box

· Click Ok

To Delete Workspace:

· Click Window Menu

· Point to Workspace

· Click Delete Workspace…

· Select a Workspace

· Click Delete

To Show / Hide Navigator Palette:

· Click Window Menu

· Click Show / Hide Navigator
To Show / Hide History Palette:

· Click Window Menu

· Click Show / Hide History 

To Show / Hide Commands Palette:

· Click Window Menu

· Click Show / Hide Commands

To Show / Hide Transitions Palette:

· Click Window Menu

· Click Show / Hide Transitions

To Show / Hide Audio Effects Palette:

· Click Window Menu

· Click Show / Hide Audio Effects

To Show / Hide Video Effects Palette:

· Click Window Menu

· Click Show / Hide Video Effects

To Show / Hide Effect Controls Palette:

· Click Window Menu

· Click Show / Hide Effect Controls

To Show / Hide Info Palette:

· Click Window Menu

· Click Show / Hide Info

To Show Timeline Window (if it is hided):
· Click Window Menu

· Click Timeline

To Show Monitor Window (if it is hided):

· Click Window Menu

· Click Monitor

***** 6th Class *****
Adobe Title Designer:
In Premiere 6.5, you have the ability to design complex titles with the Adobe Title Designer. With the Adobe Title Designer, you can add a variety of attributes to titles, use various templates to design titles, freely manipulate shapes in a title, and create custom styles that you can save and use with other title documents.
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Adobe Title Designer window A. Selection tool (left); Rotation tool (right) B. Horizontal type tool (left); Vertical type tool (right) C. Horizontal paragraph text tool (left); Vertical paragraph text tool (right) D. Path text tools E. Pen tool (left); Add anchor point tool (right) F. Delete anchor point tool (left); Convert anchor point tool (right) G. Rectangle tool (left); Clipped-corner rectangle tool (right) H. Rounded-corner rectangle tool (left); Round rectangle tool (right) I. Wedge tool (left); arc tool (right) J. Ellipse tool (left); Line tool (right) K. Sync to Timeline button L. Output to Monitor button M. New Style button N. Delete Style button 
To Create Still Title:
· Click File Menu

· Point to New

· Click Title > Adobe Title Designer Opens.

· Select Still from Title Type

· Select Type Tool and Click on Title Area
· Then Type

To Save Title:

· After Create Title, Click File Menu

· Click Save
· Select Location

· Type File Name

· Click Save

To Close Adobe Title Designer:

· After Save, Click File Menu

· Click Close

To Add Title on Timeline:
· Select the Title from Bin

· Drag the Title & Drop it any Video Track

· Then Preview

Or

· Select Target Track

· Set Edit Line Marker at 00:00:00:00 Second or as you Choice

· Right Click on Title

· Click Insert at Edit Line

To Edit Title:

· Double Click on Title from Bin or Timeline

· Then Edit 
To Create Rolling Title:
· Click File Menu

· Point to New

· Click Title

· Select Roll from Title Type

· Select Type Tool

· Click on Title Area

· Then Type

· Click Title Menu

· Click Roll/Crawl Options

· Check On ‘Start Off Screen & Check On ‘End Off Screen’

· Click Ok

· Click File Menu

· Click Save

· Select Location

· Type File Name

· Click Ok

· Then Close Adobe Title Designer

To Create Crawling Title:
· Click File Menu

· Point to New

· Click Title

· Select Crawl from Title Type

· Select Type Tool

· Click on Title Area

· Then Type

· Click Title Menu

· Click Roll/Crawl Options

· Check On ‘Start Off Screen & Check On ‘End Off Screen’

· Click Ok

· Click File Menu

· Click Save

· Select Location

· Type File Name

· Click Ok

· Then Close Adobe Title Designer

To Change Text Font:

· Open Adobe Title Designer

· Type Text

· Right Click on Text

· Point to Font

· Select as you Choice

To Change Text Size:

· Type Text

· Right Click on Text

· Point to Size

· Select as you Choice
To Change Text Alignment:

· Type Text

· Right Click on Text

· Point to Type Alignment

· Click Center or as you Choice

To Change Text Position:

· Type Text

· Right Click on Text 
· Point to Position

· Select as you Choice
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To Change Text Style:

· Type Text

· Select the Text by Selection Tool

· Select any Style from ‘Style’ List

To Get More Style:
· Click Here

· Click Load Style Library

· Select a Style

· Click Open

Shortcuts for Edit Text or Title
	RESULT
	ACTION

	Open the Title Designer window
	F9

	Increase text size by one point
	Select text + Ctrl + Alt + [image: image21.png]




	Decrease text size by one point
	Select text + Ctrl + Alt + [image: image22.png]




	Increase text size by five points
	Select text + Ctrl + Alt + [image: image23.png]


+ [image: image24.png]




	Decrease text size by five points
	Select text + Ctrl + Alt + [image: image25.png]


+ [image: image26.png]




	Increase kerning by one unit
	Alt + [image: image27.png]




	Decrease kerning by one unit
	Alt + [image: image28.png]




	Increase leading by one unit
	Alt + [image: image29.png]




	Decrease leading by one unit
	Alt + [image: image30.png]




	Increase leading by five units
	Alt + [image: image31.png]


+ [image: image32.png]




	Decrease leading by five units
	Alt + [image: image33.png]


+ [image: image34.png]




	Nudge selected object by one pixel
	[image: image35.png]


, [image: image36.png]


, [image: image37.png]


, or [image: image38.png]




	Nudge selected object by five pixels
	[image: image39.png]


+ [image: image40.png]


, [image: image41.png]


, [image: image42.png]


, or [image: image43.png]




	Increase kerning by five units
	Alt +[image: image44.png]


 + [image: image45.png]




	Decrease kerning by five units
	Alt +[image: image46.png]


 +[image: image47.png]




	Select next object higher in stacking order
	Ctrl + Alt + ]

	Select next object lower in stacking order
	Ctrl + Alt + [

	Draw a shape from its center
	Alt + shape tool

	Maintain aspect ratio while drawing shape
	[image: image48.png]


+ shape tool

	Maintain aspect ratio while scaling
	[image: image49.png]




	Scale from the center of the bounding box
	Alt - drag

	Scale (Area Type)
	Drag resize handles

	Switch to selection tool
	V, ESC, or Ctrl

	Switch to rotation tool
	V

	Switch to any type tool
	T

	Switch to pen tool or any anchor point tool
	P

	Switch to any rectangle tool
	R

	Switch to ellipse tool
	E

	Switch to wedge tool
	W

	Switch to arc tool
	A

	Switch to line tool
	L

	Ignore style's font when applying
	Alt -click style swatch

	Switch to Edit mode
	Double-click or marquee object with selection tool

	Constrain rotation to 45-degree increments
	[image: image50.png]


-drag rotation tool

	Constrain move to 45-degree increments
	Begin dragging rotation tool then [image: image51.png]


-drag

	Align type (type object only)
	Ctrl +[image: image52.png]


 +L (left), Ctrl +[image: image53.png]


 +C (center), Ctrl +[image: image54.png]


 + R (right)

	Show Tab Stop dialog
	Ctrl +[image: image55.png]


 + T

	Bring to front
	Ctrl +[image: image56.png]


 + ]

	Bring forward
	Ctrl + ]

	Send backward
	Ctrl + [

	Send to back
	Ctrl +[image: image57.png]


 + [

	Insert © symbol
	Ctrl +[image: image58.png]


 + 1

	Insert ® symbol
	Ctrl +[image: image59.png]


 + 2

	Start New Path
	Alt + pen tool on segment

	Continue Path
	Alt + pen tool on start/end point

	Adjust Handle Independently
	Alt + pen tool -click Bezier handle

	Add Anchor Point
	[image: image60.png]


+pen tool -click segment or [image: image61.png]


+delete anchor point tool - click anchor point

	Delete Anchor Point
	[image: image62.png]


+ pen tool -click start/end point, or [image: image63.png]


+ pen tool or add anchor point tool -click anchor point

	Convert Anchor Point
	Alt + pen tool, add anchor point tool, or delete anchor point tool -click anchor point

	Center Object(s) Horizontally
	Ctrl + [image: image64.png]


+ H

	Center Object(s) Vertically
	Ctrl + [image: image65.png]


+ V

	Display Font Browser Dialog
	Ctrl + T

	Send Frame to External Monitor
	Ctrl + E


***** 7th Class *****
About transitions
The visual change from one clip to another is called a transition. To add nuance, texture, or special effects between video clips, Premiere provides a variety of transitions, such as wipes, zooms, and dissolves. The simplest transition is the cut, where the last frame of one clip leads directly into the first frame of the next. The term comes from film editing, where a cut means splicing two shots together. Very often, a cut is the most effective way to move from one scene to the next. Other transitions, however, are useful in setting a mood or adding a creative element to your project.

The transitions included with Premiere typically involve the end of one clip and the beginning of the next. For example, the Cross Dissolve transition might dissolve the last second of one clip into the first second of the next. Some transitions, such as Inset, can involve both clips in their entirety, depending on the desired effect.


To Show / Hide Transitions Palette:
· Click Window Menu

· Click Show / Hide Transitions

To Display a Description of a Transition:

· Display Info Palette

· Select the Transition in Transitions Palette

· (The description appears in the Info Palette.)




To customize the Transitions palette: 

· To animate the icons, choose Animate from the Transitions palette menu. 

· To stop icon animation, deselect Animate from the Transitions palette menu. 
· To show all transitions within a folder, click the triangle next to the folder name to expand the folder.
· To hide all transitions within a folder, click the triangle next to the folder name to collapse the folder. 

· To hide selected transitions, select one or more transitions in the Transitions palette (Shift-click to select multiple transitions), and then choose Hide Selected from the Transitions palette menu. 

· To restore hidden transitions, choose Show Hidden from the Transitions palette menu. The hidden transition appears dimmed. To restore the transition, select it and choose Show Selected from the Transitions palette menu. 

· To reorder a transition in the palette, drag the transition up or down to a new location in its folder, or into another folder. 

· To reorder a folder in the palette, drag the folder to a new location. With large folders, collapse the folder first. 

· To create a new folder, click the New Folder button ([image: image66.png]


) or choose New Folder from the Transitions palette menu, type a name, and click OK. Drag transitions to the new folder. 

· To rename a folder, select it, choose Rename Folder from the Transitions palette menu, type a name, and click OK. 

· To delete a custom folder, select it, click the Delete Selection button ([image: image67.png]


) or choose Delete Folder from the Transitions palette menu, and click Yes. The folder is removed, and all included files are placed in their original folders and dimmed.

Note: If you delete a default folder, the folder and all its contents are dimmed

· To find a transition, click the Find button ([image: image68.png]


) or choose Find from the Transitions palette menu, type the name of the transition, and click Find. To find the next instance, click Find Again. 

· To expand all the folders in the palette so you can view all the transition names, choose Expand All Folders from the Transitions palette menu. 

· To collapse all the folders in the palette to preserve space or clean up the palette, choose Collapse All Folders in the Transitions palette menu.
To Add Transitions (A/B Editing Workspace):
Note – Transitions is used between two clips into Transition Track.

· Set a Clip into Video Track 1A
· Set another Clip into Video Track 1B

· Select and drag a transition from the Transitions palette to the Transition track in the Timeline window, between the overlapping areas of the two clips. The duration of the transition is automatically adjusted to the overlapping area.

· Then Preview
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2
Add two instances of one transition to the overlapping space (left) and reverse the direction setting for the second (right).
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3

Previewing Transitions
To preview a transition, you can either build a preview of, or render-scrub, the section of the Timeline containing the transition. With render-scrubbing, you can see the transition's effect quickly, without waiting for Premiere to build a preview file.

To build a preview of the transition:

In the Timeline, move the yellow work area bar so it covers the transition and press Enter (Windows) or Return (Mac OS) to build a preview.

To render-scrub the transition:

Hold down Alt (Windows) or Option (Mac OS) and, when the cursor becomes a downward-pointing arrow ([image: image71.png]


), scrub in the Timeline window's time ruler.
Changing Transition Settings
You can change a number of settings for each transition, including the transition direction, the start and end values, the border, and anti-aliasing. The following procedure describes how to display the Transition Settings dialog box and change settings common to many transitions. Settings specific to transitions are available by clicking Custom in the Transition Settings dialog box.
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A. Start/End slider  B. Border thickness  C. Track selector  D. Edge selector   E. Anti-aliasing selector  F. Forward/Reverse selector 

To Change Transition Settings:

1. Open the Transition Settings dialog box in one of the following ways:

· To change the settings for a single instance of the transition in the video program, in the Timeline either double-click the transition or select the transition and choose Timeline > Transition Setting.

· To change the default settings of a transition for this and future projects, double-click the transition in the Transitions palette.

2. Adjust any of the following settings and then click Ok:

· To see the starting and ending frames of the clips, select Show Actual Sources. This option is not available when you’ve double-clicked a transition in the Transitions palette.

· To change the initial and final appearance of the transition, use the Start and End sliders. (For example, if you want to create a picture-in-a-picture effect, use the Zoom transition and set the start and end sizes to about 30%; then add a border and move the center point to the desired corner.) Hold down the Shift key to move the start and end slider together (For example, to set the start and end size of the transition to 30%).

· To adjust the width of the optional border on the transition, drag the Border slider. The default Border is none. Some transitions do not have borders.

· To select a border color, click the color swatch, select a color from the color selection window and then click Ok.

· To specify which clip begins the transition, click the Track selector on the left side of the transition’s thumbnail to toggle back and forth starting with clip A (the left clip) or clip B (the right clip). You can also click this selector from the transition’s thumbnail in the Timeline window if the thumbnail is large enough.

· To change the orientation of the transition, click an Edge selector on the transition’s thumbnail. The Edge selectors are small triangles bordering the transition icon.

For example, the Barn Doors transition can be oriented vertically or horizontally. Some transitions do not have Edge selectors because the transition has only one orientation.

· To make the transition play forward or backward, click the Forward/Reverse selector in the upper right corner of the transition’s thumbnail. For example, the Clock Wipe transition can play clockwise or counterclockwise.

· To adjust the smoothness of the transition’s edges, click the Anti-aliasing selector in the lower right corner of the transition’s thumbnail. Clicking cycles through the values Low, High and Off.


Anti-aliasing smooths the edges or borders of the transition, improving its quality. You can also set anti-aliasing from the transition’s thumbnail in the Timeline window.

· To adjust the center point of the transition, drag the small box that appears in the Start and End images. For example, the Iris Round transition can be centered toward the side or corner of the image.

· To change settings specific to the transition, click Custom. (Transitions without additional controls do not include a Custom button.)

Note – To change the duration of a transition in A/B Editing mode, hold down Ctrl (Window) or Command (Mac OS) and drag an edge.

Replacing a Transition

You can replace a transition by simply dropping a new transition on top of the old one. When you replace a transition, the alignment and duration are preserved; however, the settings for the old transition are discarded and replaced by the default settings for the new transition or by the master transition settings if you have set them in the Transitions palette.

To Replace a Transition:

· Drag the new transition from the Transitions palette onto the existing transition in the Timeline window.

Using Some Important Transition

Using QuickTime Transitions

In addition to the transitions available in Premiere, you can add QuickTime transitions to a program. If you have installed QuickTime transitions, they will be available in the QuickTime folder in the Premiere Transitions palette.

To add a QuickTime Transition:
· In the Transitions palette, click the triangle to open the QuickTime folder. 

· Drag the QuickTime transition to the desired location in the Timeline. 

· In the Select Effect dialog box, choose the transition you want to add. 

· Modify the transition settings as needed, and then click OK.

Using the Image Mask Transition

You can use a black-and-white bitmap image as a transition mask in which image A replaces the black in the mask, and image B replaces the white in the mask. If you use a grayscale image for the mask, pixels containing 50% or more gray will be converted to black, and pixels containing less than 50% gray will be converted to white. Many third-party image collections can be used with this transition.

To Add an Image Mask as a Transition:

· Drag the Image Mask transition from the Special Effect folder in the Transitions palette to the Transition track of the Timeline. The Image Mask Settings dialog box appears. 

· Click Select Image, and double-click the image file you want to use as a transition mask. The image you selected appears in the Image Mask Settings dialog box. 
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· Click OK. 

· Preview the Transition

[image: image74.png]



The Image Mask transition reveals the B clip through the white pixels of a selected image file, and the A clip through the black pixels. 

Using the Gradient Wipe Transition

Adobe Premiere can use any importable grayscale image as a gradient wipe. In a gradient wipe, image B fills the black area of the grayscale image and then shows through each level of gray as the transition progresses until the white area becomes transparent. When you create a Gradient Wipe transition, you can specify the "softness" of the transition's edges. Many third-party image collections can be used with this transition.

To Create a Gradient Wipe Transition:

· Drag the Gradient Wipe transition from the Special Effect folder in the Transitions palette to the Transition track of the Timeline. The Gradient Wipe Settings dialog box appears. 

· Click Select Image, and then double-click the file you want to use in the wipe. The image you select appears in the Gradient Wipe Setting dialog box. 

[image: image75.png]



Adjust the softness of the transition's edges by dragging the Softness slider. As you drag the slider to the right, image A increasingly shows through image B. 

· Click OK. 

· Preview the Transition. 
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Result of Gradient Wipe transition on clip 

[image: image77.png]



.mpg file





.wav file





.jpg file





If we disable clip on timeline the clip will not be preview into monitor window.





If we lock a clip on timeline, we couldn’t move the clip on timeline.





After insert a video clip on timeline sometimes we need to delete audio but when we select video clip the audio will be selected for that reason we need unlink video and audio to delete audio.





To maintain Aspect Ratio of a clip we have to use ‘Maintain Aspect Ratio’ option. After use this option follow Monitor window.





You can change frame rate of a clip from Frame Hold option.





Preview





After edit clip on Timeline you can watch you’re editing to Monitor window for that you have to preview.





After edit clip on Timeline you can render work area. After render move ‘Edit Line Marker’ on clip and watch you’re editing to Monitor window.





After Click





Title Area





At the time of save title, the title will be added automatically in Project Window





Adobe Premiere 6.5 Setup





You can change your object or text style like Font, Font Size, Font Color, Leading, Kerning, Texture etc. from Object Style option.


Type Text


Select the Text


Then Change as you Choice





Transitions Palette Menu





Triangle








To Preview:


Hold down Alt (Windows) or Option (Mac OS) and, when the cursor becomes a downward-pointing arrow (� INCLUDEPICTURE "D:\\Installer Software\\Premiere 6.5\\Help\\images\\arowdown.gif" \* MERGEFORMATINET ���), scrub in the Timeline window's time ruler.
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